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Introduction 

 

The Anywhere Travel Companion (ATC) is a unique and high 
performance touch screen handheld device developed specifically for 
mobile navigation both in the aircraft as well as in an automobile. 
The automotive application instructions, basic operations and care 
of the unit are covered in a very detailed and easy to read manual on 
the HP 310 Companion CD in the original shipping carton. 
Familiarizing yourself with this device using those instructions first 
may help you gain an excellent understanding of how this powerful 
device works. 

This manual contains complete operation instructions for the 
Anywhere Map and XM WX application built into this device.  

Starting Up 

To activate/deactivate the ATC, press and hold the power button. 
The initial screen you’re presented with after a cold power up is the 
Main System Menu: 

 

NOTE: Use the Power button to turn the power on or off. If the 
device is switched off while navigating on the ground or in the air, 
the GPS stops working. Consequently your position is not 
calculated, the track log is not saved, and the navigation stops. 
When you turn the device on, your ATC continues navigating as 
soon as the built-in GPS determines the location. 

Tapping the Navigation button will take you to the Oasis control 
panel: 

 

Oasis is the standard interface of the machine, which offers access to 
3-D street mapping, contact and phone number management, and 
entertainment.  

To begin using Anywhere Map, simply tap on the Anywhere Map 
button and after a brief loading sequence you’ll be presented with 
the a map screen similar to this one: 
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Map Screen 

 

 

NOTE:  NEVER REMOVE THE ATC MEMORY CARD while 
Anywhere Map is running as database corruption may occur. 

OVERVIEW: 

The main map screen is highly interactive and can be easily 
customized to show your choice of standard aeronautical chart items 
as well as numerous (unique to Anywhere Map- features including 
Cones of Safety, a Virtual Glideslope indicator, and Obstacles as low 
as 200’ AGL. Many of the items you see on the main map screen are 
able to be tapped for more information. A single tap on items such 
as airports, obstacles, navaids, graphical METAR flags, and 
MOAs/Restricted areas will bring up a small text box containing 
‘quick’ information about the selected item. These text boxes will 
auto-hide after a few moments, OR can be cleared immediately by 
tapping the “Clear All Tags” button that appears just below the 
airplane icon while any text boxes are activated. Double tapping 
(tapping the same item twice in rapid succession) will bring up the 
complete details for the selected items. Airport data screens deliver 
items such as radio frequencies, remarks, raw textual METAR/TAF 
information, runway data, and Taxi Express™ GPS enabled taxiway 
diagrams. Adding the selected airport or navaid item to the flight 
plan can also be done on these screens. For map screen 
customization instructions please reference the VIEWS section of 
this manual.  

The map screen also contains features that are always displayed and 
are always located in the same fixed position for easy reference 
regardless of user configuration.  

Starting in the top left, you’ll find the Flight Timer 
area. This area can be used to display 3 different 
timers. FT or Flight Timer can begin at your 
designated taxi/runway speed and keeps track of the 
time aloft. ET or Elapsed Timer is a ‘stopwatch’ ty

function, which can be handy on approach. ZT or Zulu Time can 
also be displayed making second-guessing your time conversion from
local to Zulu time a thing of the past. To use this area, simply tap on
it to change modes until the desired timer is selected. The ET can be 
cleared by tapping on the elapsed time and then tapping the blue 
“Clear ET” tag that comes up. Zulu time is calculated autom
using the internal NMEA GPS clock. 

pe 

 
 

atically 

Directly below the Flight Timer area is the weather status area. The 
WX status displays quite a bit of data about the XM WX portion of 
Anywhere WX with a single line of text. This single line will toggle 
between the current state of the WX Radio receiver/age of the 
NEXRAD file displayed and the quality of the signal being received 

from XM Satellites. Listed below are the items that can be displayed 
and what they mean: 

STARTUP- Anywhere Map is connecting to the Bluetooth Radio in 
the ATC for the com port and connection of the WX Radio (WX 
Worx Dual Ensemble receiver). 

INIT= Initialize. Anywhere Map is searching in an attempt to 
connect to a WX Radio.  

ACT CHK= Activation Check. Anywhere Map is checking the 
activation status of the WX Radio.  

REQST= Request. Anywhere Map is requesting the appropriate 
items for the WX Radio unit to decode for display on the map 
screen. 

WX: --- = the first NEXRAD radar file has not been received yet. 
Normally the first radar file takes 4-6 minutes to appear on the 
screen 

WX:0m = The current radar file being displayed on the screen has 
just been delivered via the XM WX broadcast and is currently 0 
minutes old. 3 minutes after this image is delivered the time will 
then show “WX: 3m” 

ACTXM = The WX Radio receiver has confirmed to Anywhere 
Map that it is not activated or that it hasn’t been used recently and 
doesn’t know how to decipher the current encryption of the weather 
files being delivered by XM satellites. See page 19 of this manual for 
more WX Radio Activation/Refresh instructions. 

XM-ANT = XM Antenna is not connected or is reported to be 
defective by the WX Radio box. Try removing/re-inserting the WX 
Radio antenna. If this message persists, the antenna may need to be 
replaced. 

Signal quality is reported by 3 green bars for GOOD signal, 2 yellow 
bars for FAIR signal, 1 red bar for POOR signal, and NOXMSAT 
which means the antenna is connected but doesn’t have any 
reception normally due to a poor/non-existent view of the sky. 

NOTE: After boot of the Anywhere Map software and 
connection to the WX Radio box has been established through 
Bluetooth, the signal quality to XM satellites will be displayed 
following INIT, ACT CHK, and REQST phases have completed 
(approx 30 seconds or less). Once an acceptable level of signal 
(GOOD or FAIR) has been maintained for 4-6 minutes, the first 
WX files will begin to show up automatically on the map screen. 
More on the XM Weather operations can be found in the XM 
Weather section of this manual. 

The last line on the top left map screen area is the Range indicator. 
The example shown on the previous page illustrates a 37 statute mile 
range. This distance is measured from the aircraft position on the 
map screen to the top arc of the compass rose. 

Moving on to the upper right corner of the screen you’ll find the 
GPS status.  

 

This area will display “NO SAT” if the internal GPS 
hasn’t acquired at least 3 satellites sufficient to provide 



a 3D position on the map screen. Once the GPS acquires your 
position this area will display your ground speed and GPS altitude in 
feet above mean sea level or MSL. GPS acquisition time usually 
takes 15-30 seconds with a clear view of the sky, but can take 2-3 
minutes if the unit has been transported 60 or more miles while 
powered OFF. Upon GPS acquisition, the map screen will localize 
to show the aircraft location in the proper position on the map 
screen. The GPS status area has 2 areas that can be tapped for more 
information.  

Tapping ‘KTS’ will quickly change the map from metric to English 
measurements resulting in ground speed being displayed in miles per 
hour or ‘MPH’ and map distances are converted from nautical miles 
(NM) to statute miles (SM). Tapping ‘MPH’ will change back to 
metric measurements. 

Tapping the altitude readout will recall the strength of satellite lock 
currently held by the internal GPS. ‘3D 10SAT’ for example can be 
interpreted as: 3 dimensional lock tracking 10 satellites. This readout 
reverts to the GPS altitude automatically within a few moments.  

The top center of the screen just above the peak of the compass rose, 
a 3-digit number shows the current heading of the aircraft. 

The lower left and right corners of the map screen are reserved for 
the active flight plan data. The lower left corner will display the 
estimated time enroute (ETE) or estimated time of arrival (ETA) 
once a flight plan is activated. The distance to the next waypoint or 
to the destination, appear in the lower right. If the map doesn’t have 
an active flight plan, the lower left and right corners of the map will 
be void of these fields. These features will be further described in the 
Flight Plan section of this manual.  

Note: this button will always return you directly to the main Map 
screen. 

  displays the version of Anywhere Map software you’re using 
along with the effective dates of the 28 day GPS mapping data installed. 

 closes the Anywhere Map software completely when you’re done 
flying. 

TOOLBARS: 
 The ATC uses a highly sensitive touch screen as the primary input 
means. Anywhere Map features and tools have been categorized into 
toolbar buttons that can be recalled by tapping the transparent 
button in the lower left. Tapping on the toolbar icon will recall 2 
banks of tool buttons shown below: 

 

Left Side top to bottom: 

 Universal Finder: Search utility for airports, navaids, 
fixes/intersections, & user waypoints. 

 Direct To: Sets up “GPS Direct” from current loc. to any 
airport, navaid, fix, or user waypoint.  

 Find Nearest: Quick list closest airports, navaids, fixes, ATC 
center, AWOS, cheapest fuel, etc. 

 Flight Plan Manifest: Full details of flight legs, save/load 
flight plan, Route Wizard, etc. 

 Flight Calculator: Calculate density altitude, true air speed, 
and winds aloft. 

  Toolbar show/hide toggle: Show/hide left and right 
toolbars on edges of map screen. 

Right Side top to bottom: 

 Emergency: Single tap to enter E-mode and pick airport and 
activate emergency decent VNAV. 

 Personal Digital Copilot: Setup reminders for switch tanks, 
lower gear, & begin decent. 

 Views: Quickly select and modify your preset map display 
configurations. 

 WX Settings: Show/hide XM WX items from the map 
display.  

 Zoom/Backlight settings: Preset zoom levels, backlight 
adjustment, & night/day toggle. 

Tools: Leaves map screen for setup of aircraft profiles and 
advanced functions. 

Page 3 



 UNIVERSAL FINDER 
The Universal Finder is a powerful way to find items in the 
Anywhere Map database to which you may navigate including 
airports, navaids, fixes, and user waypoints. 

 

The Universal Finder screen is constructed with the following 
sections: 

Type Tabs across top: these tabs allow you to select which type of 
item to find – airport, navaid, fix, and user waypoint 

FAV / NEAR: These buttons allow you to list the results in the 
selection box either by the most frequently used or by nearest to 
your current GPS position.  

Range/Bearing: This box, to the right of the history/suggestion area, 
shows the distance and bearing from your current position to the 
item you have highlighted in the list box. 

Entry box: Enter your search criteria in this box to see the list 
respond with items that fit your criteria. Use the on-screen keyboard 
for text entry if you do not see the item you’re after in the Selection 
box below the Entry Box. 

Hide KB: hides the pop up keyboard so you can see the rest of the 
UF function buttons. 

Jump: Directs Anywhere Map to jump to the item you have 
selected. If you have a GPS connected, the map will change to 
“Preview Mode” when you jump because the map is no longer 
showing your current GPS position. To cancel and return to your 
current position on the map, simply tap “Restore Position” in the 
upper right corner of the map. 

Waypoint: Inserts the item you have selected as a waypoint in the 
active flight plan. You will see a window appear that gives you the 
option to decide how the item should be inserted into the plan: as a 
new destination (new plan), as next waypoint (literally, the one 
you’ll fly to next directly from your current position), as a waypoint 
(inserts the waypoint into the flight plan sequence using the course 
as a guide for insertion), and as final destination (extends the current 
flight plan to this new waypoint as it is now the real destination, and 
occurs after the original destination). 

Info: Opens the Airport Information screen which provides runway 
data, radio frequencies, GPS enabled Taxi Express airport diagrams, 
remarks, Virtual Approach procedures, 100LL fuel prices, FBO 
facility directory, and weather information. 

Note: See item #2 on page 11 for practical usage and text entry into the 
Universal Finder. 

 DIRECT TO  
Opens the Direct To screen so you can alter your flight plan OR 
create a Direct (single leg) route to a particular point. The screen 
opens in the basic form shown below with airports listed first, in 
order of nearest to farthest. Farther down the list changes to navaids, 
again with the nearest being listed first. Finally the fixes are listed. 
You can also open the Universal Finder from here to select a more 
distant waypoint if you don’t find it in the list on this screen. 

One distinction of the ATC Direct To screen above nearly all other 
systems on the market: It shows the list of waypoints when you have 
an active flight plan. In this case you can use the Direct To to skip 
waypoints and fly direct to a waypoint much farther down the plan 
from your current position. This happens often when ATC clears 
you to bypass several short legs when departing a terminal area, for 
example. Instead of searching for a waypoint you know is in the 
plan, simply tap Direct To, and pick from the list of active flight 
plan waypoints. 

 FIND NEAREST ANYTHING™ 
This function allows you to access ATIS, AWOS, FSS, ATC 
CENTER , VOR’s, and Airports within approximately 50-100 nm 
of your current position. This is especially handy for looking up 
nearby facilities that may control SUAs or to get enroute weather 
information.  

Placing a checkmark in the Only Look Ahead box will return only 
results along your route lying ahead of your current GPS position. 
With a subscription to 100LL fuel data, you’ll also be able to search 
for the nearest Cheap Fuel. 

 
 
Pressing the Include NDB box will return both VOR’s and NDB’s 
when the search is requested. 

 FLIGHT PLAN  
A flight plan is a list of waypoints that define the route of a flight. 
Each flight plan will have at least a START POINT and a 
DESTINATION. Many flights will also include intermediate 
WAYPOINTS, which are points along a route that define the path, 
generally to keep the flight path out of undesired areas such as 
restricted airspace. 
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Tapping the  button will open the Flight Plan Manifest screen 
where you can view the leg details of your active flight plan, 
save/load a flight plan, and even add wind data and/or VNAV 
attributes to each leg. You can also re-arrange the waypoints, clear 
the flight plan from the map, or access the Route Wizard tool. 

 

The flight plan screen contains a listing or manifest of the flight legs 
and waypoints as well as three management tabs (Edit, Create, and 
File). In the manifest window you can see the data that has been 
calculated for each of leg of the flight including waypoint name, 
course, speed, winds, VNAV, time, distance, fuel used. The flight 
totals are summed at the bottom of the manifest area. 

EDIT Tab: Contains the buttons that allow enroute flight plan 
modification. Frequently a controller may order changes to your 
flight plan that require addition or deletion of waypoints, re-
ordering waypoints, or even entering holds. The functions on this 
first tab were chosen because they are the most common activities.  

Add WP: Opens the Universal Finder screen so you can lookup an 
airport, Navaid, fix or user waypoint for inclusion as a waypoint in 
the current flight plan. This is repeated from the Edit tab. 

Delete WP: After selecting an existing waypoint (single tap) in the 
flight plan manifest, this allows you to delete the waypoint. The 
result will be that the flight course will then run from the prior 
waypoint directly to the next waypoint. This is repeated from the 
Edit tab. 

VNAV: After selecting a waypoint, allows you to specify an altitude 
at which you want to cross the waypoint. Once set, a blue arrow will 
display next to the waypoint designator (upper center of map screen) 
showing you whether to climb or descend as you approach the next 
waypoint. In addition, a required rate of climb/descent number will 
display in the lower right corner and a target arc will arch across the 
flight course showing the point at which you’ll reach the specified 
VNAV altitude based on your current rate of climb/descent and 
your ground speed. This is repeated from the Edit tab. For more 
information, see VNAV Concepts page . 

Next WP: Allows you to select a waypoint from the manifest and 
make it the next waypoint in the plan. This will NOT delete any 
intermediate waypoints that may exist, but does set the waypoint 
number, bearing and distance data on the map to the waypoint 
selected. Anywhere Map will normally “follow” your flight progress 
and will automatically know which flight plan waypoint is “next” 
but in those cases where it gets out of sync with the pilot, this button 
allows you to synchronize the software. 

Winds: Opens a screen to enter wind speed and direction. There are 
two cases of using winds in the flight plan: 1) manual entry of the 
winds (available for both Anywhere Map and Anywhere Wx 
customers) and 2) forecast winds from the winds aloft feed in XM 
weather (Anywhere WX customers only). If XM is available, then 
the winds for the altitude selected in View Setup > Wx will be used 
to calculate speeds, times, and fuel. If XM is not available, then 
winds can be entered manually using this WINDS button or you 
can leave them at zero for a no-wind plan. 

Hold: Toggles with UnHold. This function will PREVENT the 
map from advancing to the next waypoint automatically when a 
flight plan waypoint is passed. If ATC were to instruct you to “hold 
east of OSWEGO” and you were approaching this VOR from the 
east, tapping this button before arrival would prevent the waypoint 
sequencing logic in Anywhere Map from noting station passage, 
even though you would be over-flying the VOR on each holding 
pattern orbit. To resume navigating, tap the UNHOLD button 
when inbound to the VOR, and the next waypoint will advance 
automatically when crossing the VOR. 

Move Up / Dn: These buttons will take the selected waypoint/leg of 
the flight plan and move it up or down in the order of the flight plan 
allowing a re-sequencing of the waypoints in the manifest. 

Close: Closes the flight plan screen and returns to the map with any 
changes made in this screen implemented on the map. 

CREATE Tab:  

These flight planning functions are primarily used in the creation of 
new flight plans and the modification of existing ones. The most 
common functions are repeated from the Edit tab. 

� Add WP: Opens the Universal Finder screen so you can 
lookup an airport, Navaid, fix or user waypoint for 
inclusion as a waypoint in the current flight plan. 

� Delete WP: After selecting an existing waypoint (single tap) 
in the flight plan manifest, this allows you to delete the 
waypoint. The result will be that the flight course will then 
run from the prior waypoint directly to the following. 

� VNAV: After selecting a waypoint, allows you to specify an 
altitude at which you want to cross the waypoint. Once set, 
a blue arrow will display nest to the waypoint designator 
(upper center of map screen) showing you whether to 
climb or descend as you approach the next waypoint. In 
addition and required rate of climb/descent will display in 
the lower right corner and a target arc will arch across the 
flight course showing the point at which you’ll reach the 
specified VNAV altitude based on your current rate of 
climb/descent. 

� Next WP: Allows you to select a waypoint from the 
manifest and make it the next waypoint in the plan. This 
will NOT delete any intermediate waypoints that may 
exist, but does set the waypoint number, bearing and 
distance data on the map to the waypoint selected. 

� Route Wizard: Tapping the Rt Wizard Button will bring 
up the Route Wizard screen. Enter the full ICAO Airport 
identifier in the From and To fields. Each Via (optional 
waypoint) identifier should be separated by a space. See the 
Route Wizard explained in further detail with an example 
on page 13. 

� Reverse: This function will reverse the order of the flight 
plan in use for the return trip.  
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FILE Tab: 

LOAD button: Calls up a screen containing previously created and 
saved flight plans. If the flight plan you wish to load shows on the 
screen, tap the filename and tap OK.  

Save: After creating a flight plan on the ATC, enter this screen and 
type a unique filename in the “save as” box of this screen. For 
instance to save a flight plan from PTS to MCK you might type 
“PTS 2 MKC” in the SAVE AS box and tap the Save button.  

Clear: This will remove the current flight plan from the screen. This 
will not delete the flight plan from the memory. 

Delete: This will permanently remove the flight plan from the 
PDA’s memory. 

Note: The Anywhere Map computes fuel consumption, course, and ETA. 
Entering Aircraft Profile information will make these calculations more 
accurate. Place wind direction in the top text box, and place the wind speed 
in the lower text box. These values may be easily edited with the stylus on 
the slider controls. These values can be shown as the wind vector in the 
upper left corner of the screen unless changed or overridden. Tap OK when 
done. 

Creating Flight Plans  

There are several ways to create a flight plan on the ATC. One 
important thing to remember when creating flight plans is that the 
Start Point is the aircraft’s location on the map screen. If the internal 
GPS has acquired its position, this is where your flight plan will 
begin. If you’re indoors and the GPS hasn’t acquired its position you 
can manually ‘jump’ your aircraft to the desired Start Point before 
beginning your flight plan creation. The only exception to this rule 
is the Route Wizard method. Here are the different methods you 
can use to create flight plans in the ATC.  

1. Map based flight plan creation: If the waypoint icon 
you wish to use is visible on the map screen, simply 
pick the destination from the screen by double tapping 
on it and tap the Waypoint button on the information 
screen that appears. If you did not have any active 
flight plan, the map screen will return and you will 
have a ‘GPS Direct’ flight plan from the Start Point to 
the selected item. If there already one or more legs 
created, you’ll be presented with a multiple choice 
screen to make sure the item is integrated properly 
into your flight plan: 

� Go Direct To- This option will erase any current flight 
plan and go ‘GPS Direct’ to the selected item.  

� As Next Waypoint- This option will add the selected 
item before all other waypoints chronologically, 
making it your next plotted waypoint. 

� As A Waypoint- This option will automatically add 
the selected item chronologically into your existing 
flight plan. 

� As Final Waypoint/Destination- This option will add 
the selected item on as the last waypoint in the existing 
flight plan. When creating a multi-leg flight plan in 

chronological order, each waypoint added would be 
done so using this option.  

Database search based flight plan creation: Tap the UNIVERSAL 

FINDER  icon on the toolbar and enter the identifier. Then tap 
the Waypoint button on the information screen that appears. The 
Universal Finder screen is very handy to use, even if you you’re 
unsure of the exact ident. The universal finder allows you to save 
many keystrokes entering an airport or fix identifier as it always lists 
the eight nearest matches to the partial identifier entered. This ‘auto-
complete’ function can nearly eliminate the need to enter the entire 
identifier. See the Universal Finder section of this manual for more 
instructions of this feature. 

DIRECT TO based flight plan creation: Tap the DIRECT TO  
button and select a waypoint from the list of nearby airports, 
navaids, fixes, or waypoints from your active flight plan. 

Rubber Band Flight Plan creation: The Rubber Band Flight 
Planning tool is fast, easy, and convenient. This tool allows you to 
‘drag and drop’ your course line to different airports or nav items (or 
any infinite point on the map) thereby creating the flight plan 
course. This is a handy feature for making minor in-flight 
adjustments due to ATC vectors, weather and terrain deviation, or 

just for sight-seeing. Activate this feature by tapping: + 

 and you’ll see on the map a red circle on your actual 
waypoints, and a blue circle over the midpoints of each leg. The blue 
circles allow you to create a new waypoint by dragging it to the 
desired position thus making it an actual waypoint in your flight 
plan (which turns it red). The red circles (waypoints) can also be 
‘dragged and dropped’ to change waypoints/destination on the fly. 

Route Wizard based flight plan creation: The Route Wizard is a 
quick and easy way to create a flight plan if you know the starting 
point and destination of your flight, and the names of the waypoints 
or VOR’s you are going to use. The idents you enter must be typed 
correctly, or they will be left out of the flight plan by default. Tap 

the  + Create tab + Route Wizard button and enter in the airport 
of origin’s identifier in the From box. Next, enter the airport 
identifier for the destination airport in the To box. Airports must be 
entered using four letters/numbers. Prefix three letter identifiers with 
a “K” if in the lower 48 United States, “C” for Canada, and “P” for 
Alaska, for example.  
 
Finally, use the ‘VIA’ box to enter the VORs and fixes you wish to 
travel by way of , if any. Separate each entry with a space. 
VOR/NDB’s must be entered as three letters and fixes must be 
entered as 5 letters. Tap the OK button, and you will be returned to 
the Flight Plan Manifest screen.  
 
Look over the flight plan you’ve just created. If any of the legs are in 
the wrong spot, you can highlight the leg by single tapping on it 
then tap the Move Up or Move Down button until it is in the right 
position.  
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Here is an example of a flight from Johnson County Exec to 
Atkinson Muni. Via CNU vortac: 

FROM: kojc  TO: kpts VIA: cnu  
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VNAV CONCEPTS:  
The basic concept of VNAV is the TARGET ALTITUDE. 
Anywhere Map allows a target altitude to be assigned to any 
waypoint in a flight plan. If a target altitude is active for a waypoint, 
the software will compute the rate or climb or descent necessary to 
reach that altitude, based on the time-to-fix and altitude difference. 
When the next waypoint has a target altitude associated with it, the 
software will draw an up or down arrow next to the fix name at the 
top of the screen, indicating that a climb or descent is required.  
 

Tap +Views Settings+Format tab+VNAV Info button to enable 
this powerful tool and the target rate of climb or descent will be 
shown in the lower right corner of the map screen. The value shown 
is not the current rate of climb/descent, but the rate of climb/descent 
NEEDED to reach the target altitude concurrently with reaching 
the fix.  

If the rate of climb or descent is greater than 200 feet per minute, a 
VNAV target altitude arc will appear in front of the aircraft at the 
point in space where the target altitude will be reached. This arc will 
span from about 20 degrees left to 20 d

Note: GPS altitude ‘jitter’ may cause this arc 

egrees right of the aircraft. 

to jitter a bit as well, but if the aircraft is in a 
steady climb or descent, this arc will show 
clearly where the target altitude will be 
reached. 

To set up a VNAV target altitude, enter 
the flight plan using any method (see Flight Plan portion of the 

manual) and then enter the Flight Plan Manifest screen . Next, 
tap once on the desired wayp nt in the flight plan listing in thi
screen – this will highlight this leg of the flight plan. Then tap the 
VNAV button at the bottom of the screen to call up the TARGET 
ALTITUDE slider. Use the slider control and/or the scrollwheel on
the side of the ATC to enter and ‘fine tune’ the target altitude. You 
may also tap in the altitude box and type in the altitude with the 
keyboard number pad if you wish. Tap OK to set the target altitud
or DISABLE VNAV to shut off VNAV coaching.  
Automatic VNAV  
When you set up a f
selected with a target altitude of the airport’s elevation plus 1000 
feet. This will result in arriving at the airport at approximately 
pattern altitude.  

IMPORTANT: R
ALTITUDE, it does not allow for any difference between GPS 
altitude and indicated altitude (which is what ATC expects every
to be using).  
 
IM
flight plan. Thus if you have a target altitude to a distant waypoint, 
and an intermediate waypoint is inserted between the distant 
waypoint and the current position, VNAV coaching will not b
till the intermediate waypoint is passed. 

oi s 

 

e, 

light plan to an airport, VNAV is automatically 

emember that VNAV is always based on GPS 

one 

PORTANT : VNAV only works on the NEXT waypoint in the 

egin 

 FLIGHT CALCULATOR  
Density Altitude: To figure the Density Altitude, type in the 

h the 

 
 

Outside Air Temperature (OAT). Use the slide bar underneat
text box to get close and then fine-tune it with the arrows on either 
side of the text box. When a temperature is entered, the deviation 
from ISA is computed and saved. If you re-enter this screen later in
the flight, the temperature value will be remembered and filled in for
you. Tap the Density Altitude button, and it will be displayed in the 
gray box above the button. 

 

True Airspeed: Enter the Indicated Air Speed (IAS) in the text box 

t 
e 

Winds Aloft: Enter the Magnetic heading of the aircraft in the box 

 

DE 

in knots. Use the slide bar underneath the text box for a general 
number, and fine-tune it with the arrows on either side of the tex
box. The True Air Speed (TAS) will show in the gray text box abov
the TAS button.  

shown. The GPS reported ground track is shown in the TRK box. 
Tapping WINDS will cause the actual winds aloft to be calculated 
and displayed. This step assumes that the altitude, temperature, and
airspeed have already been computed. To have a visual reminder of 
the wind data just entered, tap Show Vector. To hide the wind 
vector, go to the Flight Plan screen and tap WINDS and tap HI
VECTOR. 

 EMERGENCY MODE 
Replaces existing flight plan with Direct-To plan to selected airport 

 

apping this button on the toolbar also switches the display to 

nce an airport is selected by a single tap of the icon on the screen, 

with VNAV to the airport such that it shows required rate of descent
to get there.  
 
T
VIEW 6, which should be preset to your preferences for an 
emergency landing.  
 
O
this mode shows a “VNAV target arc” based on your current rate of 
descent and ground speed, which is actually the point at which 
you’ll reach the ground (based on field elevation).  
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ince the VNAV target arc is based on actual GPS rate of descent 

 tap the 
p 

S
and GPS groundspeed, the target arc is already compensated for 
headwinds or tailwinds. Due to GPS altitude jitter, the target arc 
will jump around somewhat however in an actual emergency if it 
consistently falls short of the target airport runway then you will 
likely NOT reach the field at the current glide speed and 
configuration. To cancel E-mode, tap File > Flight Plan or
Hot Key programmed for Flight Plan, then tap the File tab, then ta
Clear. See VNAV Concepts on page 13 for more information. 

 PERSONAL DIGITAL COPILOT  
These settings provide numerous safety capabilities for the user. 

ing These settings remind you to perform critical steps such as lower
the landing gear and turning on oxygen. When activated, a red or 
blue reminder will appear on the screen that will either hide on its 
own after several seconds or you can hide them by tapping them 
once.  

 
 

ox 

u to switch the fuel tanks. You 
 

L. 

to the presence of an obstacle 

Optionally, you can also choose to have the ATC’s audio speaker 
sound an alert when the reminders pop up. Check the associated b
to turn on the alarm function. 

Check Fuel Pump: This reminds you to check the fuel pump as you 
pass through 1000’ AGL. 

Switch Fuel Tanks: This reminds yo
set the time interval between switch tank reminders in the text box. 

Check Landing Gear: This important reminder prompts you to 
check the landing gear when the airplane passes through 600’ AG

Begin Descent: This pops up a reminder box when the required rate 
of descent to reach pattern altitude by the time you reach your 
destination is 500 feet per minute. 

Obstacle Ahead Warning: Alerts you 
that is within 500' of your GPS altitude and within 10 nautical 
miles of your current position. 

Spiral Dive Warning: Alerts you to a continuous change in track 
with a continuous descent. 

Oxygen Warning: Reminds you to begin oxygen use when the GPS 
altitude is 12,000 MSL or above. (Remember, this is GPS altitude 
and not barometric altitude.) 

 VIEWS 
Allows you to create, save, and change map display ‘pre-sets’. Rather 

 

than making frequent and repetitive map display settings, you can 
save customized map views for specific flight needs and save them 

under a name for rapid recall. For example, you could save a map 
view for VFR Day Operations with terrain and special use airspace
turned off, but weather data, airways and fixes turned on.  

 

By saving this configuration as VFR any time you select 1VFR the 

de 

1. Tap 

preset display settings take place. You may save up to 6 different 
View configuration pre-sets. View 6 is reserved for Emergency Mo
and the settings automatically take place when you enter Emergency 
Mode.  

To create and save a map view: 

 +  

2. sing the NAVAID, Airport, Airspace, Topo (SuU rface 
tures way 

 this configuration (View 1-5). 
u 

VFR 

 

e graphical display of the screen 

 

and elevation values added  

Fea ), Format, and Weather tabs, set the display features the 
you want them to appear. 

Select which View # to assign to
NOTE: You should set up View 6 with the feature selections yo
wish to see in the Emergency Mode. 

If you wish to give the map view a special name (such as IFR or 
Day) then type this name into the View Name box on the SET Tab. 

Tap Save View and your current feature settings will be saved under 
that view. 

 What is saved in a view? 

All of the information in the View Setup screen with the exception 
of the FULL HSI setting. 

Any weather display selections (show / hide NEXRAD, Metars, etc 
and Wind vector) 

The zoom range 

What is NOT saved in a view?

Aircraft profile information 

Software settings NOT related to th

The status of the Full HSI as well as the virtual ILS and flight plan 
information  

Sample views (come preset)

VFR View – This is a “sectional” looking display with shaded 
terrain, roads, lakes, airports, towers, and SUA’s enabled  

TAWS view – This is the VFR view with color coded terrain above 
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ssed, as is terrain. Holds and airways 

ME 
pass rose display, no SUA’s or airspace information, 

set up for fast screen update rates (turn off 

 

 

IFR View – This is an “enroute chart” looking view. SUAs’s and 
class b/c/d/ airspace is suppre
MEA’s are added in.  

Approach View – IFR view with approach waypoints added in 

Weather View – the IFR view with weather enabled (weather 
systems only) 

Emergency view – a simple sparse view with Cones of Safety, D
to airport, com
but terrain turned on. 

Special considerations about the Emergency view –  
The E-View should be 
SFR’s, class b/c/d airspace and MOA’s, turn on Cones of safety and 
terrain if in a mountainous area (leave terrain off if NOT in a 
mountainous area). If private airports are enabled in E-VIEW, when
you tap on the screen to select an emergency landing field, private 
airports can be selected, of they are not shown, only public airports 
can be selected. 

NAVAID Tab: This tab shows all of the Navaid features that can be
displayed.  

 

VORs and NDBs: You may display the VOR’s and NBD’s with or 
without the Compass Roses and frequencies.  

 shown.  

ize 
 on your ground speed so you retain 

 Airport tab shows all of the airport 
ch as elevation, 

Fixes: You may display the enroute fixes, the terminal fixes, and the 
names for the fixes.  

Airways: The airways may be displayed with and without the 
number and the MEA

Holds: Holds allows the holding patterns to be shown. Auto S
adjusts the size of the hold based
one-minute legs. 

User Waypoints: User waypoints to be shown. 

AIRPORT (APT) Tab:
information that can be displayed on the map su
frequencies, runway length, Taxi Express diagrams, textual weather, 
remarks, FBO services, and virtual approaches.  

 

Elevation: displays airport elevation above sea level  

ICAO: displays airport identifier  

ATIS and Tower: displays CT and AT frequencies beside the airport 
at close zoom levels (approx 25NM) 

Marker Beacon / LOC / ILS: displays marker beacons (as circles) 
and LOC feathers for associated airports  

Distance To: displays distance from your current position to the 
airport  

Runway Length: displays the length of the longest runway (in 
hundreds) next to the airport on the map, L55 means this airport 
has at least one 5500 foot runway. This data is only shown when 
zoomed in closer than 25 NM  

Hide Small: Hides non-towered airports when zoom level (radius) is 
> 100 nm.  

Cones of Safety®: To enable the Cones of Safety feature, place a 
check in that box. If you want to display Cones of Safety for non-
paved runways, check that box also. To reduce screen clutter, you 
can also select to automatically hide the Cones at GPS altitudes 
greater than 10,000 feet MSL.  

The last section allows the user to show private airports as a dot, or 
as a dot with a name, or not at all (no check marks). 

AIRSPACE (ASP) Tab: Displays Airspace information as selected. 
In the box on the top, you control if you want the Class B/C/D 
Airspace shown, and whether floor and ceiling values of these 
airspaces should be displayed.  

 

In the lower box, the Special Use Airspace is listed. These include 
MOA, Restricted, Alert Areas, TFR’s (Temporary Flight 
Restrictions) and Mode C veils. Checking “Show Altitudes” box will 
show the SUA’s altitude of operation. There is a grayed out box 
labeled “Warn Me”, this is a future feature, not currently enabled in 
the software. You can also see more information about the SUA if 



you double-tap the center point of the airspace (at wider view levels 
there is a small dot there). This will show you the airspace, altitude 
limits, last regular hours of operation, and even the controlling 
facility frequency. 

TOPO (Surface Features) Tab: Display options regarding 
geographic features and terrain. In the Surface Features box, you 
may display the lakes, highways, cities, state lines, and towers. You 
may optionally display the name of the cities, lakes and highways. 
Placing a check in the box next to Urban Areas will allow the user to 
see the outer boundaries of urban areas in a slightly darker color 
than the surrounding terrain. You can also choose to display 
loitering-sensitive objects such as stadiums and nuclear power plants, 
and may optionally display the 3 nm veil that surrounds them. 

Data Tags are approach/departure frequency tags that appear around 
some of the higher density airspace. When zoomed out, there is a 
small green dot on which you can tap to see the frequency. When 
zoomed in, the dot is replaced with a rectangular box in which the 
frequency is displayed. 

 

In the Terrain Elevations Map section, you can choose whether to 
display terrain. Terrain is depicted in colored tiles that denote 
elevation of a point within that tile. The size of each tile is 1 mile 
square (high resolution at close zoom levels). Terrain resolution 
increases as the zoom level is changed from wide to close. This is 
done to keep the map performance optimized. Terrain color is also 
adjustable. You can choose from light, medium, or dark. In the dark 
setting the lower terrain altitude will be rich dark green.  

In the light setting the low altitude terrain will be very light green. 
Terrain color shading transitions from green to orange to brown at 
higher altitudes to finally white, making the mountain tops appear 
white. You may wish to use a lighter terrain color during the 
daylight hours if you are flying in an area with low elevations to 
improve contrast. In higher elevations it is often better to use a 
darker color.  

The Terrain Settings group select additional options:  
 
Red Above: In this mode the terrain that is above and near your 
GPS altitude is shown in 3 special colors:  

Terrain 1000’ to 500’ below the aircraft is shown in YELLOW  

Terrain 500’ to 200’ below the aircraft is shown in ORANGE  

Terrain less than 200’ below and all terrain above the aircraft is 
shown in RED  

Terrain that is more than 1000 feet below the aircraft is rendered in 
normal colors. 

Values: Turns on the display of the highest terrain value in each 
terrain tile. This is the highest elevation within that tile (in hundreds 
of feet) This is very handy for estimating the height of terrain ahead.  

Above Alt: This turns on terrain mapping only when the terrain is 
above your current GPS altitude. This can be useful for reducing 
screen clutter in mountainous areas while still seeing terrain of 
particular concern (above you). This mode can be used in 
conjunction with RED ABOVE to include the “nearby” terrain 
(1000’ to 200’ below the aircraft).  

Lat/Long Grid: Enables the drawing of Latitude and Longitude grid 
lines on the map. 

FORMAT (FMT) Tab: FMT tab allows you to set various ancillary 
display features that either enhance the map, the data displayed, or 
the navigation capability.  

 

GPS Altitude: Displays GPS derived altitude in the upper right 
corner. Note that GPS altitude is actually very close to the correct 
geometric altitude, but it may vary significantly from the altitude 
indicated by a pressure altitude, depending upon the altitude AGL 
and the local deviation from ISA temperature. Temperatures +20C 
above ISA standard will cause the pressure altimeter of the aircraft to 
read approximately 200 feet low for each 5000 feet AGL. Cross 
Track Error: Your course deviation is shown on the map in the 
lower screen center in tenths of a mile. An arrow shows you in which 
direction your course is from your current position.  

VNAV: This displays required rate of descent data in the lower right 
corner of the map when your descent to the destination airport 
pattern altitude (assuming 1000’ PA) is 250 ft. per minute or 
greater. This box must also be checked to show VNAV information 
in flight plans. For more information see VNAV Concepts on page 
12-13. 

Lat/Long: Your current position in latitude/longitude is shown in 
the bottom left corner of the map.  

Track History: This feature leaves breadcrumbs (small dots) along 
the path flown. 

Bold Course Line: This function places a heavy black line on either 
side of the flight plan course line in normal flight. The course line is 
green for the active leg and aqua for all other legs of the flight plan.  

Statute Miles: This toggles all map data between statute miles and 
nautical miles. 
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Day Mode: Toggles between the day color set (light background) 
and the night color set (black background).  

Max/Min Mode: When you select the Maximum screen display 
mode (tap rough air button, then MAX) the button that cancels this 
mode will be in the lower right instead of the lower left corner of the 
screen. 

Trip meter: Displays a Trip meter in the lower left corner that is the 
total distance flown since last reset. To reset the trip odometer, tap 
File > Tools > Odometer/Trip meter. 

Hide DG: This removes the compass rose from the screen entirely.  

EFIS Arc: This changes the compass rose view to an EFIS ARC 
display. This is also known as the “look-ahead” view because it also 
moves the aircraft position on the map to the lower third so you can 
see more area ahead of you than beside or to the rear. This setting 
can also be toggled from the map screen by tapping the tan button 
that has an aircraft and DG that arcs above it.  

Full HSI: This will enable the HSI function to show on the screen 
and un-checking it will remove the HSI display leaving only the 
EFIS or compass rose. 

Draw Arc: This will draw an arc on the EFIS ARC display on in the 
compass rose view. If unchecked, the Tick marks for 10 degree 
increments are drawn but the arc is not shown. The arc drawn when 
this is checked is the “zoom range” shown when radius (below) is 
checked. 

Disp: R: NM: This is very handy for knowing what range is being 
displayed on the map. It displays the distance from the aircraft icon 
to the EFIS arc/circle. It immediately sets context for the distance 
between you and items being displayed on the map such as towers, 
airports, airspace, and especially weather. The range in nautical miles 
(or statute if so set) is shown in the upper left corner of the map 
under the flight timer. If this box is unchecked, the range value will 
display briefly when changing zoom ranges and will automatically 
hide after about five seconds to save screen real-estate.  

North-Up Mode: Plane will appear in the center of the screen, and it 
will rotate instead of the map. Map screen will always have North at 
the top of the screen.  

Turn Coord: Displays a circular Rate of Turn instrument in the 
lower left corner of the map. The rate of turn, in degrees per minute, 
is shown digitally.  

Rate/Climb: Displays a Rate of Climb/Descent indicator in the 
lower right corner of the map. 

Note: A map view can be activated at anytime by selecting the desired view button 

under: .  

WAYPOINT (WPT) Tab: This tab allows you to control how 
waypoints are used in the creation of flight plans and also during the 
flight.  

 

Show Corridors: In a flight plan, waypoints designate course changes 
as you progress. Changing course as each waypoint is reached is 
usually done after you cross the waypoint (Navaid, fix, etc.) which 
also usually results in your being off course for the next leg and 
having to return to the line as you start down the next leg.  
Many pilots want to smooth the corner so they turn before reaching 
the waypoint, thereby making a nice transition from one leg to the 
next.  
 
However, in doing so they actually do not fly directly over the 
waypoint and therefore Anywhere Map needs to know whether you 
just missed it (and you intend to return to it) or whether you intend 
for the next leg to become active. The corridors have been created to 
allow "corner cutting" so that you can smooth the corners in your 
flight and still have the flight plan logic follow as you progress.  
 
The corridors are depicted as gray or red lines (red if the waypoint is 
set as a holding waypoint) that bisect the angle made by the legs that 
are inbound and outbound from the waypoint. The length of the 
line is based on the distance between waypoints and the angle made 
by the two legs. As long as you cross the corridor line, the waypoint 
will be considered "crossed" and the next leg will become active. 

Show Next Waypoint as Destination: Displays the next waypoint in 
a flight plan at top center of the screen. The waypoint can be an 
airport, fix or user waypoint. If unchecked the final waypoint of the 
flight plan is shown at the top of the screen. 

Annotate Waypoints: The waypoints you are using in the flight plan 
have data tags on them even if the names of the waypoint type 
(VOR, NDB, Fixes, etc.) are turned off in the settings.  

Estimate time to destination waypoint using FLT plan Spd:  

If this box is UNCHECKED, the estimated time to destination is 
computed using the total flight plan distance divided by the current 
ground speed. This is the method used by most GPS units, and it is 
conceptually very simple. This is Current Ground Speed mode. This 
method does not work well on “round robin” flight plans, with 
strong winds aloft. 

With the box CHECKED, the time to destination is figured using 
the TE to the next waypoint (using current GPS groundspeed) 
PLUS the sum of the TE’s for each subsequent leg shown in the 
flight planning screen, using the speed shown in the flight plan 
screen. This method is generally more accurate, but requires that the 
aircraft speed and winds aloft be properly entered so the resulting 
speed is accurate. 

Auto Start FP at Nearby Airport:  
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If this box is unchecked, when you select an airport and tap FLY 
TO, you will be asked “Start at airport?” if you are within about 3 
miles of an airport. 

If you tap NO here, the flight plan will originate at a special user 
waypoint using current GPS position on the map. If you tap YES 
here, the flight plan starting point will be at the “reference point” of 
the nearby airport. 

 

If checked it will be assumed that your answer is always YES to this 
question.  

WEATHER (WX) Tab: WX tab allows the weather products to be 
selected for display or hidden from view. It does not control 
reception of the weather data, only the display. In addition, by 
setting weather display features and then saving the view, the view 
you are modifying will always have those weather display settings 
associated with it until further modified and saved. This way, you 
can have just METARs turned on in one view, and the full 
compliment of weather features turned on in another view.  

These settings are duplicated in the  menu for quick and easy 
access.  

SET Tab: Set Tab allows you to save your recently configured 
settings under a default or custom name.  
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 XM WEATHER SETTINGS  
These check boxes turn on and off the display of the associated 
weather products. This does NOT control reception of the products 
and this varies according to the weather platform being used and the 
content being received from XM Satellite Weather, the weather data 
provider. This feature REQUIRES a WX Worx Dual Ensemble 
receiver purchased from Control Vision Corp. This component is 
optional equipment when you purchase an ATC. It also requires a 
subscription to XM Satellite Weather for the data broadcast to be 
decoded by your receiver. 

 

For XM Weather, the settings control display of the specific weather 
items on the Map. Remember, XM is a broadcast over which the 
pilot has no control. They send each file type (radar, METARs, etc.) 
on a schedule and once your system is powered on, you can only 
wait until the next files are broadcast. For example, radar is 
broadcast every 5 minutes and METARs/TAFs every 12 minutes. 
This screen also contains the ‘advanced’ button, where more XM 
controls are located including the tools required for re-activating 
your XM unit should it lose activation.  

We suggest you do not use the advanced button without help from 
Control Vision technical support. Most importantly, the status 
shows that you are receiving weather files and also signal strength. 
The Sat Error rates need to be as close to 0 as possible. The higher 
they are, the greater the chance that weather files will not be received 
properly and therefore will not be displayed. In this case, the age of 
the weather file being displayed will simply continue to count 
upward until the next file broadcast.  

Antenna placement is the single biggest reason that updated weather 
files are missed and not displayed. If you have low error rates, your 
chance of getting all the weather data is much better. 

  ZOOM Options 
Changing the range on the ATC couldn’t be easier. The scroll wheel 
on the top-right side of the chassis allows you to zoom in or out on 
the main map screen. This is an easy, tap-less way to make 
adjustments to the map range you’re viewing.  

 



Tapping the  button will recall the zoom screen and allow you to 
pick from several different pre-set zoom levels and/or activate the 
Auto Zoom, Zoom to the entire Flight Plan, Box Zoom or Pan 
Zoom tool.  

 

This screen is also used to switch between the Day and Night 
modes, enable the map panning tool and adjust the backlight 
brightness of the ATC: 

 Enables the map range to automatically decrease (zoom in) 
as you approach the next waypoint or your destination. Pressing the 
same button will deactivate this feature.  

 

Tapping  will increase the range on the map screen just 
enough to show your entire flight plan course line all on one screen. 
Also handy for viewing any possible weather threats and 
MOA/Restricted or Class airspace you may be on course for. This 
feature also puts the map into Preview Mode (disables GPS 
temporarily). Tap ‘Restore Map’ to return to the main map mode. 
The Day/Night button will toggle the color scheme to make 
Anywhere Map more useable during very bright or very dark 
conditions. Adjusting the backlight brightness (5 different settings) 

can be done with:   

 Great follow up feature to the  button. After 
enabling zoom to entire flight plan, you can quickly and easily zoom 
in on any area of interest by simply tapping down and dragging 
diagonally to draw a box on the screen. This dotted-finger/stylus 
from the screen. When you’re finished, tap Restore Map in the top 
right corner and the map screen will return with the zoom level that 
you left it at (before zooming to entire flight plan) and the GPS 
tracking will resume. 

 Tap to Pan mode enables you to move the map position 
ahead, backward, and sideways by single-tapping on the screen. Each 
time you tap, the map moves to that position. If you have a GPS 
connected, then the map will also go into Preview Mode, which 
reminds you that you are looking at an area that does not include 
your current position.  

Hint: To cancel the Preview Mode, tap the red square in the upper 
right corner, Restore Map. 

Hint: To cancel the Tap to Pan mode, tap the cancel icon in the 
lower right corner. This will restore the ability to interact with the 
map items. 

 TOOLS 
Tapping the Tools menu button will switch from the main map 
screen to a page that looks like this: 

 

 This feature acts as a poor man’s autopilot, not because it 
controls the airplane, but because it helps you keep the airplane on a 
constant heading and/or altitude.  

 

You can either use current altitude or set an altitude target. You set 
the current heading and a target heading ‘bug’ triangle displays at 
the top of the screen showing you the allowable heading deviation 
window. 
Once the aircraft has strayed from course far enough for the ‘bug’ to 
exceed the limits, an alarm will sound and an alert box will remind 
you of the deviation. To shut off Flight Following, simply tap Clear 
All. 

 This function allows you to modify a flight plan right on 
the map by dragging the course line to a new point and “dropping” 
it. The point at which you drop the course line becomes a new 
waypoint in the flight plan. When you activate this mode, a red 
circle will appear at each waypoint that is currently in the flight plan. 
Each segment (leg) of the flight plan course will have a thin blue 
circle positioned about half way along it. You drag and drop these 
circles to modify the flight plan in the following ways: 

Modify an existing waypoint: Drag a red circle to move a waypoint. 
The original waypoint will change to the new point at which you 
drop the red circle. 

Add a waypoint: Drag a blue circle to insert a waypoint. Once you 
begin dragging a blue circle, a waypoint will be created wherever you 
drop it. 

Page 13 



Delete a waypoint: Drag the red circle that represents the waypoint 
you want to delete to either the red circle for the waypoint before or 
after the one you’re deleting. Drop it on top of the red circle before 
or after, and the waypoint will be deleted. 

 After a flight, log it by double tapping on the timer block 
in the display.  

 

Tap  + to call up the logbook screen which already 
knows the aircraft tail number, type, date of flight, and flight 
duration. Tap Log Flight and allocate the flight time between day 
and night, and IFR and VFR conditions of flight, then tap Record. 
This data is now saved to the memory of the PDA and may later be 
transferred to your desktop computer to be printed and stored. 

 After a flight, log it by tapping on this menu item. The 
time, date, etc. will be saved in the log book. 

 

 This screen contains the two trip odometer resets that 
can be used to track total distance flown for a flight and for each leg. 
Resets automatically each time the program is started.  

 

  Delete WP: To delete a waypoint, first select the 
waypoint in the Select user waypoint screen. Tap the Delete WP 
button. A screen will pop up asking you Erase user waypoint? Tap 
Yes, this will bring up the Create/Edit User Waypoint screen with all 
of the boxes blank. Tap OK, this will bring you to the main map 
screen. The waypoint has been deleted. If waypoint cannot be 
deleted, make sure it is not in use in a flight plan on the screen.  

 

Import WP: Anywhere Map accepts Garmin WPT (Waypoint) files. 
They become user waypoints in the map system and may be used as 
any user waypoints. Select the desired file from the list on the screen, 
tap OK and the waypoints will be read into the map system. A 
maximum of 1,000 user waypoints is allowed. If you wish to exceed 
that number, you’ll need to break the data into multiple files.  

Purge FPs: To delete all of the FPxxx waypoints in the system, 
simply tap the Purge FPxxx button. These files are created when the 
user uses the Direct To feature; it is the point at which you are at the 
time you say Direct To.  

Make New WP: Tapping the Make New button on the Select User 
Waypoint screen will bring up the Create/Edit User Waypoint 
screen. To create a waypoint at your current location, simply tap 
CURRENT LOC. This will place the latitude and longitude in the 
appropriate boxes on the screen. You can also manually enter the 
desired Lat/Long so the point can actually be saved and added to 
your flight plan before you arrive at that point. To name the 
waypoint, tap in the Name box, and enter a name in the box. 

Delete All WP: Tapping the Delete All button will delete ALL of the 
user waypoints in Anywhere Map. When this button is pushed, a 
box comes up that says Erase ALL user waypoints? Tapping Yes on 
this screen will erase all user waypoints. Tapping No on this screen 
will take you back to the Select User Waypoint screen. The changes 
will take place when you tap OK on the Select User Waypoint 
screen and return to the Main Map screen. 

Edit WP: By tapping the Edit WP button on the Select User 
Waypoint screen, you may edit user waypoints in Anywhere Map. 
First select the waypoint you want to edit in the Waypoint Name 
box, tap Edit WP. This will bring up the Create/Edit User 
Waypoint screen. You may change any of the information in the text 
fields, including Name, Comment, Latitude, Longitude, Range and 
Radial. 

 Allows you to use the HSI for guidance to Airports, 
navaids, or along your flight plan segments.  

Even without a flight plan you can use the HSI to guide you to an 
airport or Navaid along a specific radial that you prescribe. For 
example, you may be approaching an airport from the west but want 
to intercept and track inbound to it on the 220 (SW) degree radial, 
just as if there were a VOR on the field.  
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Check “Slave to flight plan” to cause the HSI course arrow to 
automatically align with the flight plan segments. Tapping Universal 
Finder pops up the Universal Finder window so you can search for 
any type of navigation point to use for the HSI.  

 
 
Once a “target” (Airport or Navaid) has been selected, the COURSE 
and AUTO buttons are enabled. Tap COURSE to pop up a screen 
that allows the HSI needle course setting to be entered. Tap AUTO 
to set the course to the radial that the aircraft is currently on relative 
to the target. Hide will cancel the display of the HSI needles. The 
Sensitivity selection sets the value of “one dot” of needle deflection 
on the HSI.  
 
For VORs and NDBs you can set a specific radial to track to/from 
the Navaid by double-tapping the Navaid on the screen and then 
checking the Enable box and specifying the radial/course to use. The 
RUNWAY button is used to activate the virtual ILS function.  

 Sim Mode allows you to ‘fly’ a flight plan from your 
desk or couch for practice. Tapping this button will bring you to a 
new screen where you can enter your desired simulation altitude, 
heading, and speed. Click >Start to begin, or tap Disable to turn 
Sim Mode off.  

 The search grid is a handy tool for creating a consistent 
grid to fly in a search and rescue mission. To set the grid, first 
establish the location of the starting point using the latitude / 
longitude entry screen. This is reached by tapping Set Location. See 
Latitude / Longitude Input screen for details.  
Leg Length: This is the length of each leg of the search grid.  
Total Width: This sets the total width of the search area and spans 
from the first leg to the last leg.  
Track Spacing: This specifies the distance between legs for the grid.  
Initial Course: This is the direction of the first leg. Of course, each 
return leg will have the reciprocal course and each cross leg will be 
90* from the search legs. 

Create: Once the parameters for the grid are set, tap Create to 
generate the grid.  

To remove the grid, go to the Flight Plan Screen, tap the File tab, 
then tap Clear. The grid will be removed from the map. 

 This section allows you to set up the arms for your 
aircraft and then lock them so each flight is simply a matter of 
entering the weights associated with the flight.  

 
First, uncheck the Lock Arm box so arm values can be entered. 
Next, using your Pilot’s Operating Handbook plus any 
supplemental weight information from the aircraft’s Weight & 
Balance certificate, fill in the Arm items for each applicable part of 
your airplane. Calculate fuel in pounds (gallons x 6) or check the 
appropriate radio button.  
 
If your aircraft’s basic empty weight includes a full load of oil, leave 
the field blank. Some older aircraft refer to Licensed Empty Weight 
that does not include drainable oil. In this case, it must be added in 
the Oil Quarts field. Oil weighs 7.5 lbs per gallon, or 17/8 lbs per 
quart. After filling in the fields, tap Lock Arm again to preserve the 
arms.  
Now enter the weights for each parameter for the flight you are 
about to take. Tap Calculate to get total Weight, Moment and 
Center of Gravity arm (CG ARM). Use the CG ARM value on your 
Center of Gravity envelope chart found in the P.O.H.  
 
Note: The weight and balance settings are saved as part of the 
aircraft profile that is created and saved in Aircraft Settings. So when 
you set up an aircraft (especially if you will use Anywhere Map in 
more than one airplane) make sure you set up the weight and 
balance data for the airplane BEFORE you save the aircraft profile. 
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Note:  this button will always return you directly to the main 
Map screen. 



Airport Data Screens: Double tapping on an airport,  or searching 
by ident through Universal Finder will open up the Airport Data 
Screen. This screen has 8 different tabs across the top which host a 
wealth of information about the facility.  

 

The first tab provides runway data, field elevation, range/bearing 
from your current GPS position, and a ‘stick’ layout of the runways. 
Tapping the red feather icon will extend the centerlines of the 
runways on the map screen. Tapping the ‘D’ icon will open the Taxi 
Express, GPS enabled diagram of the airfield. See Using Taxi Express 
section on page 31 for more information on this powerful safety 
feature.  

 

The second tab provides the appropriate COM radio frequencies, 
AWOS phone number, and Localizer frequencies (if available) for 
the selected airport. 

The third tab contains airport remarks.  

 

The fourth tab contains FBO facility information.  

 

The fifth tab contains current fuel pricing information for each fuel 
providing FBO on the field. The fuel prices and FBO facility 
information are updated via the Download Center at 
www.anywheremap.com 

 

The sixth tab displays local restaurant and hotel information. Most 
facilities listed are located either on the field, or within 1 mile.  

 

The seventh tab offers a list of Virtual Approach Procedures. These 
are a top-down view of the approach path with automatic VNAV 
assistance. These are NOT part 91 approved plates, but instead act 
as an excellent situational awareness tool on arrival to the selected 
airport even if the field doesn’t offer any actual published approach 
procedures.  

 

The eighth and final tab displays the raw/undecoded METAR and 
TAF delivered through the XM Satellite Weather broadcast.  

 

Taxi-Express™ displays an aircraft’s GPS position on an airport 
diagram during taxi operations. This brings pilots an added measure 
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of safety at airports they are unfamiliar with or during night 
operations.  

The Taxi-Express chart lets you monitor ground position while 
communicating with Tower and Ground as well as other aircraft. 
Taxi-Express charts are derived from FAA Terminal Procedures. 
Taxi-Express is built into the ATC. 

USING TAXI-EXPRESS: 

 

1. Select an airport and open its Information screen.  

Double-tap the runway diagram in the top right corner of the 
Airport Info screen. 

The Taxi-Express diagram appears and will show your live GPS 
postion over it if you’re near the field. 

A soft blue ‘up arrow’ key in the lower left corner of the diagram 
produces a menu when tapped that’ll allow you to ‘Zoom to Fit’ the 
diagram to the screen. This menu also contains the ‘close diagram’ 
button which will return you to the Map screen.  

SETTINGS MENU: 
Tapping  +  will take you to the second menu page that 
looks like this:  

 

AIRCRAFT SETTINGS: 
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An aircraft profile saves all of the settings that are tied to a particular 
aircraft in a single file that can be loaded and saved to the file system 
of the Pocket PC. This is very convenient for the pilot who flies 
multiple aircraft.  
 
The following information is saved in an Aircraft Profile: 

All of the information on the Aircraft Settings Screen: + 

+ Aircraft Settings.  

All of the information on the Weight and Balance Screen: + 

  

To create an aircraft profile, set up the values in the Aircraft settings 
screen, as well as the weight and balance screen as desired, and tap 
the SAVE button in the aircraft settings screen. This will pop up a 
screen that allows you to name the aircraft settings file. In most cases 
the default name, which will be a combination of the aircraft make 
and model and tail number will suffice.  
 
To load an aircraft profile, go to the Aircraft settings screen, and tap 
the LOAD button. This will pop up a list of stored aircraft profiles 
on the system. Double tap on any entry or tap once and tap OK to 
select it. 

These parameters are used for flight plans, Cones of Safety, and 
flight timer operation. In addition, when you save the profile, the 
weight and balance data currently in use are also saved under this 
aircraft profile making them easily usable on subsequent flights.  

Fuel onboard: This is the total usable fuel on board in gallons. 

Cruise GPS: This is the average fuel burn in gallons per hour for the 
enroute portion of the flight other than the first hour.  

1st Hour GPS: This is the first hour fuel burn which is normally a 
bit higher than cruise due to the high power settings associated with 
take off and climb. 

Cruise Speed: This is the normal cruise speed in knots. You can 
enter this as True Airspeed if you use winds in the flight plan to 
compensate. Otherwise you can use an average ground speed 
(considering winds separately) and disregard using winds in the 
flight plan.  

Cruise Altitude: Cruise Altitude is the altitude used for Sim Mode 
operations and for displaying Cones of Safety when a GPS is not 
connected. This is overridden by the GPS altitude when in flight.  



Flight Timer: This is the speed at which you want the flight timer to 
automatically initiate. Usually this is set at a speed faster than 
taxiing, but less that rotation speed so the timer starts on the takeoff 
roll. 

Cones of Safety: 

Glide Range: These parameters set the Cones of Safety calculation. 
By setting the glide ratio, the Cones of Safety can be sized properly. 

Glide Altitude: The altitude from which the glide range can be 
achieved. 

Remember, the Cones of Safety are NOT compensated for winds at 
any altitude. They are merely an assistance to making a good forced 
landing decision but the pilot MUST account for wind in the final 
airport decision. 

Load, Save, Delete: These allow the aircraft profile to be saved (takes 
you to the profile list screen), loaded (also goes to the profile list 
screen) from the existing list, and deleted from the system. Weight 
and balance data is saved with the profile.  

Cones of Safety: Around each airport there is a region of airspace 
from which an airplane can safely glide to a landing. We refer to 
this space as the Cone of Safety.  

The Cones of Safety are represented by a thin green circle around 
each airport. In the night mode, the Cones stand out against the 
dark background. The circle’s diameter varies with the aircrafts 
altitude above the field and with the pre-set glide performance.  

To set up the Cones of Safety, you must first go to  + + 
Aircraft Settings enter in the glide ratio of the aircraft into the 
appropriate boxes. You can usually find this information in the 

POH. Once you have entered this information in the appropriate 

boxes, then go to: +View Settings +APT Tab. Place a check mark 
in the box next to Cone of Safety. The cones will now be shown 
around all airports. If they are not, it is because the aircraft is sitting 
on the ground or, if no GPS is attached, the map “thinks” the 
aircraft’s altitude is below that where the CoS are visible. To check 

this go to: + + Aircraft Settings and set the Cruise 
Altitude to some value above 3000' for example. The green CoS 
circles should now show on the map around each airport.  
 
Caution: The Cones of Safety are not compensated for wind. It is 
wise to stay away from the down-wind side of the cone. The Cone 
converges on a “reference point” of the airport, generally the center 
of the airfield. In other words, do not continue to use the Cone of 
Safety when you are trying to land, but rather concentrate on the 
task at hand.  

 

Cones of Safety® 

GPS Settings: Allows you to configure several parameters pertinent 
to the GPS including an output port for the GPS data/steering 
corrections for integration with an auto-pilot in an experimental 
aircraft. This feature is only available when using the BlueLink 
Autopilot adapter available from Control Vision. The instructions 
for configuring this feature are included with the adapter.  

Checking the “Lock Heading below 2 MPH” box on this screen will 
enable enhanced stability of the map screen while sitting still on the 
ground. 

Timer Settings: Allows you to setup or clear the different timers 
available in the ATC. “Reset FT” button will clear the Flight Timer. 
The Flight Timer is also cleared automatically when the Anywhere 
application is closed and reopened. “ET Countdown” provides a 
field where you can enter a time value to count down from rather 
than standard stopwatch function. This screen also allows you to set 
the minimum speed that you want the Flight Timer to start. 

Bluetooth Manager: This button launches the Bluetooth browser in 
the ATC. This browser gives you the ability to connect to the WX 
Worx receiver box. Follow the onscreen commands to link up, then 
click the ‘back/return to map’ screen to resume navigation. See Using 
XM Weather on page 33 for more details on WX receiver connection 
through Bluetooth. 

XM Status: Allows you to view the statistics of the active XM WX 
connection. The total count of weather files received and the age of 
the most current file are displayed here. A ‘quick’ view of this screen 
can called up right from the map screen by tapping the WX status 
line in the top left one time. This screen will come up by double 
tapping on the same area. 

XM Radio: Allows you to tune the audio channel and adjust the 
volume level in the WX Worx Dual Ensemble receiver that is 
connected through Bluetooth to the ATC. The audio signals are 
output directly from your WX Worx receiver through an optional 
cable which connects to your compatible headset or entertainment 
jack in the audio panel. This feature requires an additional (to your 
WX data subscription)monthly subscription to XM Satellite 
Weather. 

XM Settings: Shows the connection status of the WX box and gives 
you access to manually open the “Advanced” / Receiver Activation 
screen manually. You should never need to visit this screen unless 
advised by Technical Support. 

Color Tables: 3 different buttons give you the ability to launch the 
XM weather color keys over the map screen. 

 
 IR SAT COLOR CHART 

Shows relative colors (in gray) of the IR Satellite Imagery with dark 
charcoal being the lowest cloud top and light purple being the 
highest. 
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 NEXRAD COLOR CHART 

Shows colors of the NEXRAD for relative storm intensity from 
green being the lowest precipitation intensity and magenta the 
highest. 

 ECHO TOPS COLOR CHART 

Shades of gray denote the highest altitude at which a radar return 
was received in that geographic tile. In other words, this shows the 
tops of the radar returns. This is NOT necessarily the tops of the 
clouds! For example, you could have a very large area of clouds that 
go from 2000’ AGL to FL120. The IR Sat shows the tops of the 
clouds at FL210 using the appropriate color coding for that altitude. 
There is precipitation and it shows on radar. But the precipitation 
does not begin at FL210. Instead, the precip begins at 17,000’. So 
the color coding of the EchoTops would be for the lower altitude. In 
addition, EchoTops, being a radar product, are not filtered like the 
color-coded radar is at the bottom (low intensity) end of the scale. 
That means that an EchoTops will show all precip regardless of 
intensity where the radar will only show precipitation from a certain 
level of intensity upward. EchoTops, therefore, give you a clue to 
things that are happening but that do not yet show up on radar. 
This is especially handy in convective situations where EchoTops 
“fill in” the gaps between storm cells painted by radar. When you see 
this, you can expect convective activity (at least bumps) in that area 
even though radar does not paint any colors there. You may want to 
go around the area of the two cells instead of between them, when 
you see this situation. 

Using XM Weather: 
The ATC will connect automatically to an ATC configured XMWX 
weather receiver. The ATC will not connect to third party XMWX 
receiver units, even if they are Bluetooth equipped. 

XM weather can be enabled or disabled in the XM Settings screen ( 
TOOLS > SETTINGS ). 

XM may be disabled for those days when you have no need to check 
the weather. If no compatible XM weather box is found in the 
automatic search sequence, XM will be automatically disabled and 
may be re-enabled at any time. 

When XM is enabled the first time, your ATC will look for any 
compatible XMWX receiver. 

After you   connect   the ATC to a particular XMWX receiver, the 
ATC will remember that radios unique ID code and will 
automatically try to reconnect to that receiver in the future. 

This is referred to as being PAIRED with a receiver. Your ATC can 
only pair with one receiver at a time, however it is a very simple 
process to pair it with any receiver at any time. 

Connecting with a PAIRED receiver 

Under normal circumstances, your ATC will be paired with a 
XMWX receiver. This connection process is automatic and takes 
place in just a few seconds. The power to the Bluetooth radio 

system is controlled automatically. When Anywhere Map is 
launched from the ATC startup screen, the Bluetooth radio is 
enabled (powered up) by the Map software. If the ATC detects the 
paired receiver on power up, the Bluetooth connection with this 
device will automatically be established as the software starts up. If 
the Bluetooth radio in the ATC is off (no blue LED) the software 
will automatically start the Bluetooth system, this may take 15-30 
seconds. The actual connection takes only a fraction of a second to 
establish. The XM Status area of the map screen will show each step 
as it happens… 

BT ON < Please Wait> C O NNECT INIT ACT CHK REQST SIGNAL 

The map is frozen for 15-30 seconds while the Bluetooth is being 
turned on (the first two steps). 

This happens only when starting Anywhere Map or whenever the 
ENABLE XM button is pressed. The other steps may take another 
15-30 seconds to complete, but they happen in the background as 
you use the map. Some of these steps may happen so quickly that 
they do not always show up in the XM status area. Once the XM 
connection progresses to the SIGNAL STRENGTH state, weather 
files can begin being received. 

If the matching XMWX weather radio is not detected within a short 
time, the XM weather status in the ATC is switched to  
 NORADIO   and this value is displayed in the upper left corner of 
the screen, and the system stops searching for the missing radio. The 
status of the XM weather system is set to DISABLED. At this point, 
the Bluetooth radio is also shut down to save power. 

This results in the blue LED going dark. 

Manual Connection 

To later connect to a Bluetooth XMWX receiver, simply power up 
the weather receiver, and go to the TOOLS > SETTINGS > XM 
Settings screen, and press the ENABLE XMWX button. 

This will cause the Bluetooth connection process to be repeated and 
the connection process will be repeated, exactly as above. 

XM Activation and Refresh 
In order to use an XM weather receiver, your radio must be 
“activated” by a special signal from the XM radio satellites. This step 
is normally completed for you at Control Vision before the XM 
radio is shipped. However, your XM radio my “lose” its activation 
from time to time due to inactivity. This circumstance is usually 
evidenced by the Wx status in the upper left corner of the screen 
showing ACTXM, followed by the XM Radio Activation window 
opening automatically: 

Radio ID: If the Radio Id is shown at the top, then you have a good 
Bluetooth connection. Continue down the items below. If you do 
not see the Radio ID, then please power down your system and 
restart it. If this screen reappears and you still don’t see the Radio 
ID, then call Anywhere Map Technical Support.  

Signal Strength: If the signal strength is GOOD (3 green bars), then 
your antenna is properly installed and “seeing” satellites. If signal 
strength is Fair or Poor, move the antenna (or turn the airplane) 
until it shows GOOD. This is critical to proper operation. If the 
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signal strength is NOXMSAT, then either your antenna is not 
connected properly, you have a bad antenna, or the antenna is 
completely out of view of the satellites (the plane is in the hangar). 

XM Status: If the Status shows None, then your unit has probably 
lost activation. Call XM (800-985-9200), give them the Radio ID 
and ask them to refresh the radio for you. Your unit MUST be 
running and displaying this screen for the reactivation to work! 
Within about 10 minutes after XM initiates the refresh, you should 
see codes on this line: “M1” for Aviator Lite or “M128” for Aviator. 
You may see a 0 or 3 there as well. This is no problem. 

XM Activation: Once the codes in XM Status begin appearing, this 
line will change from “Not Activated” to “Partially Activated”. Once 
the proper codes are received, this line will show “Aviator Lite” or 
“Aviator”. Now simply tap DONE and you will return to the map 
where the XM unit will reinitialize as normal. The activation process 
is one in which your receiver’s identification code is sent down to 
the radio over the XM satellites. The receiver then stores this 
activation code internally for a certain time period. If you fail to 
keep your subscription up to date, the receiver will be deactivated 
and will no longer operate until it is activated by XM again. Note 
that to activate your radio use this screen, you must have your XM 
radio receiver module connected and the antenna in an area of good 
reception. 

METARS and TAFS 

 

Anywhere WX delivers weather information originating with the 
National Weather Service and broadcast by XM Satellite Weather. 
Included are two types of text reports: METARs which are 
scheduled hourly observations, and TAFs which are forecasted 
conditions at an airport usually during a 24 hour period.  

Graphical METARs can be ‘read’ first by color. The top color 
indicates ceiling while the bottom color is for visibility.  

Blue indicates high VFR conditions. 

White indicates VFR conditions.  

Yellow indicates Marginal conditions.  

Red indicates IFR conditions.  

Magenta indicates Low IFR conditions.  

 

The above graphic: now would indicate IFR ceiling, with Marginal 
visibility.  

Single-tapping a reporting airport or one associated with a graphical 
METAR on the map screen will give you a ‘quick/translated’ view of 
the METAR showing Altimeter, Temperature, Dewpoint, Ceiling, 

Visibility and Wind direction and Speed. Double tapping the airport 
and then tapping the WX tab in the Airport Information Screen will 
open the full UNDECODED METARS showing the full coded text 
METAR as created by the NWS. 

Updating ATC 

 

The ATC can be connected to your desktop, laptop, or tablet PC 
running Windows 2000, NT, XP, or Vista for updates.  Before any 
updates can be installed, you must register the ATC Product 
Activation Key.  This key can be found on a silver sticker located 
under the battery cover of the ATC and also on your invoice.  
Register this code online at: 
http://www.anywheremap.com/registration/  

After registering you’ll need to download and install the Update 
Center.  The Update Center (UC) application manages all software 
and database upgrades for your ATC by automatically downloading 
the information and will prompt you when ready install to the ATC 
device itself. The UC application can be downloaded from 
http://updatecenter.anywheremap.net 

If you are prompted to install Visual Studio Redistributable, do so, 
but it is not necessary to restart your PC when prompted, you 
should wait until the Update Center is fully installed. 

After installation, the Update Center can be found in Start>All 
Programs>Anywhere Map>Anywhere Update Center. Double click 
on it and it will place an icon in the system tray down by the clock. 
Double-clicking the icon will open up the main window. The first 
time you run Update Center, you will need to go to File>Settings 
and enter your User Name and Password (twice to verify it).  

Exit out of AWM so that on the ATC you see the three main icons. 
Connect the ATC with the supplied USB cable, you will see a sync 
icon on the ATC.  

Clicking the button “Check for Updates” will make the UC check 
the server for any new chart databases, TFR/SFRs, Airport/FBO 
facility directory, Fuel Prices, software upgrades, and/or other 
updates since your last upgrade. Select Yes when prompted to 
download the updates.  

When the downloads are complete, click “Install Updates” to begin 
upgrading the ATC with the updates you just downloaded.  

Once complete, disconnect your ATC from the PC and press in the 
reset button (found on the right side of the device). You are now 
ready to use the ATC with the current updates. 

http://www.anywheremap.com/registration/
http://www.anywheremap.com/downloads
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